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Last Time:
» Group Project Overview
 Tolerance Analysis
« CETOL
e Intro to GD&T

Tonight:
e Intro to GD&T

« Motion analysis with Pro/E




Geometric Dimensioning and Tolerancing (GD&T)

Position tolerance requires Datums, Basic Dim’s and Tolerance

Fig. 8-7 & 8-8, B. A. Wilson, GD&T App. And Intr., 2010

Datums establish how to measure the part, Basic dimensions
state theoretical location & Position Tolerances state allowances




Geometric Dimensioning and Tolerancing (GD&T)

Principal Advantage

» Key advantages of
position tolerances:

e Clarity — Part is
located and
removes ambiguity

* Increase tolerance
Zone

* Bonus tolerances
from material
modifiers

* Go/No-Go Gagin . .
N9 Fig. 8-23, B. A. Wilson, GD&T Fig. 8-24, B. A. Wilson, GD&T

App. And Intr., 2010 App. And Intr., 2010




Geometric Dimensioning and Tolerancing (GD&T)

Example

Fig. 8-1, B. A. Wilson,
GD&T App. And Intr.,
2010




EXERCISE - Design Tolerance Analysis
Tolerance study with GD&T

I BLOCKS {Active) - Pro/ENGINEER Education Edition =10 x|
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EXERCISE - Design Tolerance Analysis aen

Set Datums

» This will establish the

datum feature references
* Set FRONT datum as A

(Primary datum)
» Select FRONT

* RMB > Properties

 Change name to A

» Select last type

e Placement > On
Datum

* OK

* Repeat setting RIGHT as

B and TOP as C

I B-BLOCK (Active) - Pro/ENGINEER Education Edition [ Surface...

File Edit Wew Insert Analysis Info Applications Tools Window Help

[Nefine,..
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EXERCISE - Design Tolerance Analysis

Set Datums

» Repeat for other post-
block.prt

e Set FRONT as A
e Set RIGHT as B
e Set TOP as C

i POST-BLOCK {Active) - Pro/ENGINEER Education Edition

File Edit Wew Insert Analysis Info  Applications

Tools  Windaw Help
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EXERCISE - Design Tolerance Analysis

Set Basic Dimensions

» Set the dimensions
that locate the hole as
Basic on B-BLOCK .prt

* Repeat for post on
POST-BLOCK.prt

B B-BLOCK (Active) - Pro/ENGINEER Education Edition
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EXERCISE - Design Tolerance Analysis

Create GD&T Feature Control Frame

B Geometric Tolerance

Model Refs |Datum Hefsl Tol\-’aluel Symbnl&l Additional Te:-:tl Ok

Cancel

[,

» Create a position
tolerance for the hole on
B-BLOCK.prt

ek Dakumn
Basic Dim

Gt B-ELOCK. FRT

Select Model... |
Copy From

Reference; Placement:
Typi I Feature j Type I Dimenzion j
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iandert ooenat ne ian i
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EXERCISE - Design Tolerance Analysis

Create GD&T Feature Control Frame

| ll Geometric Tolerance X
File Edit view I
* Set the datum o EE | — Mode{Refs  Datum Refs | To)value | Symboals | Additional Text II
references for the | Damma I Unordered | __Cancel

position tolerance s | o
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EXERCISE - Design Tolerance Analysis

Create GD&T Feature Control Frame

» Set tolerance value to
.010

B Geometric Tolerance x|
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EXERCISE - Design Tolerance Analysis

Create GD&T Feature Control Frame

B Geometric Tolerance
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EXERCISE - Design Tolerance Analysis

Finish Tolerance

» Change the tolerance
type on the dimension
to symmetric

» The dimension should
appear as shown

I B-BLOCK {Active) - Pro/ENGINEER Education Edition

Fie Edit Wiew Insert Analysis Info Applications Tools Window Help
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EXERCISE - Design Tolerance Analysis

One more time...

@ POST-BLOCK (Active) - Pro/ENGINEER Education Edition

File Edit Yiew Insert Analysis Info Applications Tools Window Help
* Repeat the process of [oocpaqc|ccswrirnc |Oreaaasron|sao|zsux]e]
- LI o Select items such as Dimensions, Sections, Trajectaries, Tolerances, Surface Finish or other Features for editing
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EXERCISE - Design Tolerance Analysis

Analyze gap between edges

e Start a new CETOL
analysis (Analysis >
CETOL)

» Select horizontal basic
dimension and position
tolerance from each
component

« MMB when done

¥ BLOCKS {Active) - Pro/ENGINEER Education Edition
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EXERCISE - Design Tolerance Analysis

& Tolerance Analysis powered by CETOL Technology - |E||l|

Analyze gap between edges Measurement Table

[

Marme |Nominal |T|:|Ierance |C|:| | aa_x |.0.ttachment

» Take a look at the results for

B [ POST-BLOCK

the default design objective | Featuel o
d11 3 l&|@o01 1
Of +010 g F‘OS:-BBaLt;r;KIB-BL...

B @ B-BLOCK
- £ Feature
-] di4 2,05 |&|@o01 1

- £ Feature?

Center

1

Centker

Analysis Resulks

—Measure Variakion

Stat Contribs | W Contribs Sensitivities

Sigma = 4.2426
[efield = 99,9978
DPMU = 22,264
Name Statistical Contribution
POST-BLOCK: d11 50,00 %
3 B-BLOCE;d14 50,00 %
0.01 0.03

Dimension Loop Diagram

Analysis Resulks

Expand all
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Motion Analysis

o U S i n g Cap ab i I iti eS i n [E PIST-CRANK (Active) - Pro/ENGINEER Education Edition

File Edit ‘ew Insert Analysis Info  Applications Tools Manikin  Window Help
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0
g f s e G| v |

* Visualize |
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Show * Settings ™
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EXERCISE - Motion Analysis

Open the assembly

* Download pist-crank.asm

from the Supporting

Materials page of the web
site

® PIST-CRANK has been saved.
* Select components ko alter colars,
® PIST-CRANK has been saved.

P |26
Show ~ | Settings |

|§prt

* Open the assembly

PIST-CRANK.ASM
£F ASM_RIGHT
- F BSM_TOP
£ F BSM_FRONT
§§~ &5M DEF 5
P!
[+ CRAMK-SHAF
-] ROD.PRT
f- (] PISTON.PRT
[-[ ) PISTON-PIM.F
(-] PISTON-RING
- o Insert Here

[E PIST-CRANK {Active) - Pro/ENGINEER Education Edition ;|g|5|
File Edit Yiew Insert Analysis Info Applications Tools Manikin  Window Help |
jpcpaca|oesemiiEtmc A naal@hsdtsie aald

|a fians)el

® Select components ko alter colors, ;I




EXERCISE - Motion Analysis

Switch to the Mechanism Application

 Applications > Mechanism

PIST-CRANK (Active) - Pro/ENGINEER Education Edition

File Edit Wew Insert Analysis Info | Applications Tools Manikin  Window Help

N = ©) Cu Standard
J D = E] J 3{] Cabling
JoOXe % Piping
Il joxk 9(* H k? ‘
J & iw C® I Eg welding
# Select components to alker colors. ey
Mechanica

® PIST-CRAMK has been saved.
* Select compaonents ko alter colors,
* PIST-CRAMK has been saved,
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Show * I Settings ™ |
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EXERCISE - Motion Analysis

Examine current constraints

 View > Highlight Bodies

» Green highlighting
means a body is
grounded (has no
available DOF’s)

» Other colors are not
significant except to
differentiate bodies

* There are a finite
number of colors
available...may
repeat if necessary

* Need to “un-ground”
the components to
allow motion

[E PIST-CRANK {Active) - Pro/ENGINEER Education Edition

File Edit | Wiew Insert Analysis Info  Applications Tools  Manikin i

e Render Windaw

* Select cc Realtime Rendering

* Select ot QOrientation

* PIST-CR Wisibilicy:

Display. Style

§-ﬂ | % Representation
-

Explodh
Show poee
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(L] p1sT-CF Apnotation Orientation
Fe 7 ASh Model Setup

fF At

. Leves.

%‘ASP Display Settings
b AACT
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[-(J ROD.PRT
-] PISTOM.PRT
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[ [ PISTON-RING.J
sy Insert Here

ol ]
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| B GRavTy
- A CONNECTIONS
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- 5¢ DAMPERS
| B~ FORCES{TORG)
(-7 NITIAL CONDT
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< | i
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EXERCISE - Motion Analysis

Redefine model constraints

» Switch back to the
Standard Application

» We will need to Edit
Definition for each
component in the
assembly

» Start with;

crank-shaft_one_pist.prt

[E PIST-CRANK {Active) - Pro/ENGINEER Education Edition

File Edit Wew Insert Analysis Info  Applications Tools Manikin  Window Help

=101 x|

BEEEEEEIEE

[= P T e e
1 i -
8= §= I:Hi Lol

A aaals ksl

EEEIE

|z At % e

g Select aligning axis or edge on other part,
o Select aligning axis of edge on other part.
g Select aligning axis or edge on other part,

B | & | @ &

Show * I Settings ™

sprt |
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e BB
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Regenerate
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Representstion »
Delete

Edit References
Pattern...

Replace
Reference Contral

Setup Note 4
Send To b
Trfo 3
Hide

Edt Paramsters

< I i

Redefirie selected item.
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Ex—n e
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EXERCISE - Motion Analysis

Redefine model constraints

 Examine the constraints
currently applied:

* The first constraint
aligns the center axis

* The next two align
planes

 Delete the two planar
constraints

e Select constraint >
RMB > Delete

[E PIST-CRANK {Active) - Pro/ENGINEER Education Edition

File

Edit Wiew Insert Analysis Info Applications Tools Manikin  Window Help

EEEr R e iy R R =R EEE ER
|z At % e
-

Align

24 ASM_TOP

E_F

F2DATUM F

v Constraint Enabled
Constraint Type
|5 aign ~| Fiel

Offzet

Aligr
Mew Constraint

Mew Set

| T coincident =] [NOT DEF 7]

Status

Fully Constrained
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|5,
e
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|
&3 nv]x

IPEEE T

@MHE&%"% b
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EXERCISE - Motion Analysis

Redefine model constraints

 With just the axis

=101 x|

Froperties

alignment constraint f"& “ \

remaining, click the T 1\-.

convert icon 2o N
« This icon converts [ bata
the assembly R
constraints to gl T
mechanism &
constraints —

Constraint Type

Difsst

training.
v “@A\ign x| [noroermE -] X4 STATUS : Partialy Constrained

¥ Corstraint Enabled

(@) Align x| Flip

] _[ Coincident.

Patielly Constrained

o |op
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Yo [—)
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=2 | &
= =
B
e
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EXERCISE - Motion Analysis

Redefine model constraints

* Drop down the
constraint-type menu

* Look at the available
types of motion in the list
after a co-axial constraint
has been established

e Select Pin

= PIST-CRANEK (Active) - Pro,/ENGIMNEER. Education Edition

File Edit Wiew Insert @Analysis Info  Applications  Toaols  Manikin  Window  Help

BE2E&s

G0 e ¢ B i

ut:l- ‘t" |
= Ll_

==
I =
L —

—_—
o e

| 22 /o X % Ok

E

'_'IH__?

g Select & point or planar surface on one part,

& o T

4 Pin

Placement  Mowve

zer Defined

iz alignment

Tranzlation

Mew Set

I| = Connection_1 [Figeesss

Select compn

I Select azzemb ‘i‘:"‘r Ball Lt

I Rigid

L1, Slider

?@j Cylinder
@—) Planar

traint Type

irnatic - I FIi|:||

ohztraint Enabled

El

T - [MOT DEFINE

[ wield

.z Bearing

ﬁ‘ Gerneral
- BDOF
~ Slat

| Coincident

Status

=] noT DEF 7]

Cannection Definition Mat Complete.




EXERCISE - Motion Analysis

Redefine model constraints

° Return to Placement = PIST-CRANK {Active) - Pro/ENGIMEER Education Edition
dla|Og File Eu:hilI Wi lnert analvsis  Info  Applications  Tools Manlkjnu '-;'-.l'lnjdn:u:u IHelpr_-‘
_ _ IEEE&ca| oo f &R EHE LW
* Notice the system is [l e 5 g e
prompting for the next — = — :
DOF 1_“—;_ g Select a point or planar surface on one part.
, @’E”ﬁ 6 P = Ev [HoT DEF
* In th|S Case’ a | Flacement Mowe  Flexbility  Properties
TranS|athn constraint Eﬂ I| = Connection_1 [Pin) ¥ | Constraint Enabled
Az alignrment _
e Select the RIGHT e Constrant Type |
I Select companent item Automatic j ﬂl
plane of the crank ELT I e
: elect azzembly item
h f » 7 Offset
shatt A T Coincident | [NOTDEF 7]
« Select the ¥
ASM_RIGHT plane L
from the assembly Mew Set Sl
Connection Definition Mot Complete.




EXERCISE - Motion Analysis

Redefine model constraints

» The system then

[E PIST-CRANK (Active) - Pro/ENGINEER Education Edition

prompts for the neXt DOF Fil= Edit Yiew Insert Analysis Info  Applications Tools  Manikin  ‘Window Help
» Connection is JDEQ%Jnn%\@‘ﬁ‘E' EZEvJE
labeled Rotation Axis [z e e e 2 || a2
. |
* It's actually looking =
for a reference plane 5 19| [<en =g N T
tO use as a O deg Flacement Mowve  Flesibilly  Properties
rOtatlon rEference §":‘ I| = Connection_1 [Pin) Current Position Regen value

iz aligrment
Shor Translation I 15,000 j _l II:I 0o \"‘\\

° SeIeCt the TOP Set Zero Pasition | > | \\
plane fI’Om the Cl’ank :lPIS I Select companent zero refe | | [T Epable regeneration value
Shaft I Select azzembly zero refere ™ Mimimum Limit Im

» Select the
ASM_TOP plane
from the assembly New Set

» Click Done ‘ l”

7
-~k
g, I Faminun Limit |'|E:|:|_|:||:||:| vI

Dyhamic properties > I

HCR 'Kfmg




EXERCISE - Motion Analysis

Redefine model constraints

» Notice the Connection :! PI2T-CRAME. ASM
lcon next to the part file e F BESM_RIGHT
name in the model tree _____ 7 ASM_TOR

o fF BSM_FRONT

- §>§= ASM_DEF_(CSYS

. 4 A

---H-SH.I!'.FT_EJHE_F'IST.F'RT
&[] BROD.PRT

&) BPISTOM.PRT

- [ BPISTOM-PIN.PRT

[ ] BPISTOM-RING,PRT

.. & Insert Here




EXERCISE - Motion Analysis

Redefine model constraints

* Now edit the definition
of the rod.prt

» Delete the two planar
constraints

* Notice this leaves
the axis alignment

e Convert the constraint to
a Pin type connection

[E PIST-CRAMK {Active) - Pro/ENGINEER Education Edition

Eile Edit Yiew

Insert  Analysis Info  Applications Tools  Manikin  Window  Help

ol

|pEE&GGve s BREEL B

| g A s 3L | we

=

| @y Select a paint or planar surface on one part.

¥ 07> e

= Connection_1 [Pin)
Az alignment

I Select component ikem

I Select aszembly item

=T

Flacement Mowe  Flesibility  Properties

¥ Constraint Enatled

Consztraint Type
I Automatic j Flipl

Offzet

Mew Set

| T concident = [NOTDE 2]

Status

Connection Definition Mot Complete.
1l




EXERCISE - Motion Analysis

Redefine model constraints

° For the Transl atlon I PIST-CRANK (Active) - Pro/ENGINEER Education Edition
. File Edit Wiew Insert Analysis Info  Applications Tools Manikin  Window  Help
constraint ErEpatGi|veybmEeltw - ||DrFnaaan taih
.-'F Nx" w, . 1 ?
» Select the back [EPR AL
'-l_"—I,j o»Select & paint ar planar surface on other part.

surface of the rod

[ |1:D| I | P | A “g Align ~| | T - [NOTDEFINE -] AL STATUS : Connection Defiition Cc-mpletD
Flacement Move  Flexibiity  Properties

e Select the RIGHT

Bo |1 = Connection_T (Pin) 7 Corstiaint Enatied
plane of the crank e R Constin Tipe
- Do not specific a g?, e FREETE | T
Rotation Axis 5'
* Already done with N Se )

crank shaft

» Notice the status of
the part is
Connection Definition
Complete




EXERCISE - Motion Analysis

Redefine model constraints

» Before we can redefine
the piston constraints we
need to add a datum axis

» Drag the Insert Here tab
under the rod

* Click the Create Axis
icon

* Click the RIGHT plane
on the rod

» Holding the Ctrl key,
click ASM_FRONT plane

e Click OK

[E PIST-CRANK {Active) - Pro/ENGINEER Education Edition

File Edit Wew Insert Analysis Info  Applications

Tools Manikin  Window Help

[T DATUM AXIS

Placement |Displa_u| Plopertiesl

EEEE R T e R e =

x|

iz 4 e 3 5 e

* Component redefined successfully.
® Insert mode has been activated.

g Select up ko 2 references, such as plane, surface, edge or point to place axis.

B || | &l

Show * I Settings ™

|§prt

[T] PIST-CRANK. ASM
-4 7 ASM_RIGHT
- fF ASM_TOR
Sl 1Sl _FRONT
ng A5M_DEF_CSYs
£ AR
F-[_) BCRAMK-SHAFT_OMWE_PIST.PRT

(7] "PISTOM.PRT
(] "PISTOM-PIN.PRT
i [] "PISTON-RING.PRT

RIGHT:F2[DATUM PL... Through
ASM_FRONT:F3DAT... Through

Offset references




EXERCISE - Motion Analysis

Redefine model constraints

 Resume the rest of the
assembly features

File Edit Wew Insert Analysis Info  Applications

[E PIST-CRANK {Active) - Pro/ENGINEER Education Edition

Tools Manikin  Window Help

=101 x|

EEEEEE IR e

RlER R el = )

EEEER

» Drag the Insert Here

[l % o e
E:'

tag down to the bottom B

Flesibility

ME”E I%Cyhndar j % ‘ I@Ahgn j
|

[HOTDEFINE = 4 STATUS : Connection Definition Complete.
Froperties

of the tree

= Con

R

@
£
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EXERCISE - Motion Analysis

Redefine model constraints

» Convert the original
constraint to a Pin

[l PIST-CRANK {(Active) - Pro/ENGINEER Education Edition

File Edit Miew Insert Analysis Info  Applications Tools Manikin  indow Help
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EXERCISE - Motion Analysis

Redefine model constraints

e We need to add an addition [E PIST-CRANK {Active) - Pro/ENGINEER Education Edition

Connecuon for the p|St0n Eile Edt Yew Insert @nakysis Inofo  Applicstions Tools Manikin  Window Help
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EXERCISE - Motion Analysis

Redefine model constraints

e Suppress the piston-pin
and the piston-ring in the
model tree

 SAVE

« Switch applications back to
Mechanism

 View > Highlight Bodies

» Notice no green left
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EXERCISE - Motion Analysis

Run the model

» As another check, run the
model

* Edit > (Re)connect
* Click Run

* There should be a
message saying it was
successful

 Click Yes
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EXERCISE - Motion Analysis

Drag the mechanism through its motion

* Click Drag

[ PIST-CRANK (Active) - Pro/ENGINEER Education Edition
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